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CamTrap Pro Overview  
CamTrap Pro can add tags and text comments to JPEG image files (which may be created automatically 
from avi or mp4 video files) and produce a map-based or text report of animals found in collections of 
camera trap images as detection events over a period of days or weeks. Detection events occur when 
an animal appears in a single image, or a sequence of images where the time between successive 
images does not exceed a specified duration (commonly 10 minutes). Detection of animals can be 
performed by visual inspection, simple time and pixel-based algorithms or machine vision models. 
Results from classifiers using the generic Megadetector model (as available in AddaxAI) can be loaded 
as JSON files to highlight files containing animals and show the bounding box of the detection, the 
classification category and confidence. This data is stored in the file name. Classification results can be 
applied without the host computer needing an Nvidia GPU. A number of species-specific models are 
available in AddaxAI and tags can be automatically generated from classification results, or created 
from combinations of classifier categories. AddaxAI can be installed and run from CamTrap Pro. Input 
data can be filtered to load only files which have been highlighted, in selected classification categories, 
tagged with names containing a specified string, recorded during the day or night, or separated from 
similarly classified images by more than a specified time interval. Data can be exported to a tab-
separated text file for further statistical analysis. 

Installing and Running CamTrap Pro  
CamTrap Pro can be downloaded from 
https://captionpro.com.au:444/AlekaConsulting/index.php/camtrap-pro-download-form/  
CamTrap Pro processes only JPEG format image files taken from camera traps. It adds Windows tags to 
files, optionally from a fixed range of values, and summary and occurrence reports of tagged files can 
be generated and exported. Images containing animal images are detected and flagged using JSON 
files generated by machine learning programs such as AddaxAI. These images may constitute a very 
small proportion of images recorded by camera traps. Tagging of images containing animals with the 
animal identity can be performed visually or using a species-specific image classifier, and can be 
applied directly to recorded images, or to the subset containing animals as detected via machine 
learning using the Megadetector model. A tutorial video for CamTrap Pro operation can be viewed 
here. 

  

https://captionpro.com.au:444/AlekaConsulting/index.php/camtrap-pro-download-form/
file:///C:/Users/simon/source/repos/Collateral/at%20https:/youtu.be/JDvKaprvtfs
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Camera Trap Data 
Camera trap data comprises a large number of digital image (and sometimes video) files collected by 
cameras triggered by a relative change in the levels of infra-red radiation reaching a sensor from two 
halves of an image field. Changes may be produced by an animal entering the field of view of the 
sensor, or by movement of objects or shadows within the sensor field. A flash (commonly infra-red) is 
used to record images from triggerings occurring at night. (Infra-red images are monochrome). When 
triggered, the camera may record single images, a sequence of images or a short video when 
triggered. Data is commonly stored on a removable SD card as JPEG format images, and traps may be 
active for many days between data collections. The date and time recorded by the camera (and 
possibly other local information) is shown in a bar above or below the image. Dates and times may not 
correspond to the actual time of image collection, as the camera local time may not be correctly set. 
Image file names usually contain a number which increases sequentially. An example of an image 
obtained with such a camera during daytime is shown below: 

 
Figure 1 Daytime Camera Trap image of a rabbit 

An image recorded at night is as shown below: 

 
Figure 2 Night-time Camera Trap Image of a Cat 

Although the appearance or movement of animals occupying a significant proportion of the sensor 
field will trigger the camera, movements of leaves, grass, camera position or changes in solar 
illumination will also trigger the camera, resulting in the images recorded not showing any animals. 
These non-animal triggerings may constitute up to 95% of the images recorded. Triggerings from the 
presence of animals which are not of primary interest (such as foxes) may also comprise a significant 
proportion of images recorded. Changes in the physical environment of the sensor field (such as 
removing grass and branches affected by wind) may help reduce non-animal triggerings, but may 
result in animals avoiding the area. 
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If a bait (which may be peanut butter, sesame oil or carrion) is included within the camera field of 
view, animals such as foxes or crows may spend considerable time moving around in order to eat it, 
resulting in large numbers of images of the same animal appearing in sequential images, closely 
spaced in time. The images below show a fox circling a bait. 

 
Figure 3 Fox circling a bait 

Multiple cameras may be deployed over a monitoring region, and may be left to record data for 
periods of up to 6 months (or until the batteries are run down), or they may have their storage cards 
removed and batteries replaced more frequently. Baited traps may require regular visits to refresh 
baits. 
 
Non-baited traps in highly modified environments lacking extensive vegetation cover (such as urban 
areas) have a low rate of non-animal triggering. Datasets record numerous short detections as animals 
move across the camera field of view. Longer detections occur, but are rarer. A section of such a 
dataset is shown below: 

 
Figure 4 9-day section of a 1-year Count vs Time Profile of an Urban, Non-baited Dataset 

Automated methods of detecting the presence of animals in an image using machine learning have 
been developed, notably MegaDetector, and SpeciesNet which can be run from the AddaxAI 

https://github.com/microsoft/CameraTraps/blob/main/megadetector.md
https://github.com/google/cameratrapai/?tab=readme-ov-file
https://petervanlunteren.github.io/EcoAssist/
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application. AddaxAI requires a powerful local machine with at least 16 Bytes of RAM. An Nvidia 
Graphics Processing Unit (GPU) greatly speeds processing for the MegaDetector model. MegaDetector 
in generic mode, detects any animal, vehicle or human and these results can be refined using a 
number of refining models. SpeciesNet detects different animals in a single step 
 
Machine learning facilities such as Megadetector are highly effective for common animals, but require 
substantial computing resources. By contrast, non-fatigued human vision is fast and extremely 
accurate in detecting animals, but the task of detecting animals in the thousands of images taken even 
by a single camera is daunting, and some projects may use dozens of cameras. CamTrap Pro has been 
designed to facilitate inspection of large numbers of camera trap images and tagging of images in 
which animals appear using the Windows Tags field to store the species names of animals appearing. 
Some simple detection algorithms which do not require training are provided, as well as an interface 
to results obtained from Megadetector or SpeciesNet. Megadetector is used only to detect the 
presence of animals, whereas SpeciesNet detects species in a single step. The 8000-image, 10-month 
dataset shown in part in Figure 4 from a non-baited trap in a highly modified area with little 
vegetation records animal detections in most images, but only a few detections each day. Such 
datasets are best analysed using a species-specific classifier to identify the species of detected 
animals. 
 

CamTrap Pro Data Requirements  and Processing 
In order to use CamTrap Pro for camera trap analysis, images in JPEG format should be within a folder 
structure on storage which is not read-only, as numerous temporary files are created in the image 
data folder. If the selected folder is read-only, no files are loaded. For multi-camera data sets, the 
images should be stored 1 or 2 levels below a folder whose name represents the camera identity. If 
individual images have EXIF Date or Windows Modified Date metadata the images can be sorted in 
time order. The image Modified date may reflect the time of processing rather than the time of image 
collection, but this date can be reset within CamTrap Pro if required. If data is in the form of AVI video 
files, selected frames will be extracted from these files and saved in JPEG format in the folder 
containing the AVI files. 
 
Camera trap data from many cameras collected over multiple time periods may be organised by 
grouping images from the same camera, or the same time period or both. To make best use of the 
time profile capability of CamTrap Pro, data should be organised by camera (or by site if different 
cameras are used at the same site. Shortcuts to folders can be used to do this without changing the 
organisation of the original data. If a folder containing shortcuts to other folders is selected, data from 
each shortcut destination folder will be processed separately. Where shortcuts point to folders 
containing data from the same camera but different epochs, the shortcut names should be changed to 
reflect the epoch order. An example of data from a folder containing shortcuts to the same camera 
over multiple epochs spanning nearly 4 months using a baited trap is shown below. 
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Figure 5 Data from a folder containg shortcuts 

 
 
 The images should be in a folder structure as shown below. 

 
 
 
Folders with dotted borders are optional, but Image Group folders are commonly present. Image 
Group folders contain up to a fixed number of files (either 100, 1000, or 10000) with the folder name 
containing a sequential number starting at 100 in the manner of digital cameras. When additional 
images are added and the number of files in the Image Group exceeds its limit, a new folder is created 
and file sequence numbers restart. Details of the folder structure should be set in the Options-
>General tab. 

Image Group 
(images) 

Image Group 
(Images) 

Camera  
(may contain images) 

 

Camera Group 
 

Epoch/Site 

Figure 6 Folder Tree Structure 
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Images may be contained directly in camera folders, and there may be groups of cameras at the same 
site (identified by the Camera Group folder) to facilitate detection of individual animals by their body 
or face markings. Each camera folder should have a unique name. The Epoch folder should contain 
images collected over a period of time. The name of the Epoch folder is used for correcting Modified 
date/time values. 
 
CamTrap Pro will operate if this structure is not present, but functionality such as Camera Info or time 
setting using Epochs will not work. 
 
Some examples of folder structures are shown below: 

  
 
Figure 7 Example of multiple camera folder trees using parent (left) and grandparent (right) structures. 

The parent (or grandparent) folder of the camera folder is the epoch, or time period over which all the 
images below it were recorded. An example is shown below: 

 
Figure 8 Folder structure showing epoch, camera and image group folders 

Two epochs (Week 1 27 Nov- 4 Dec 2022 and Week 2 4-11 Dec 2022) are shown, with 4 camera 
folders during the first epoch and 2 in the second. Data can be processed either by individual camera 
or collectively. 
 
A database storing tag occurrence data (TagDB_Epoch/Site Name_CameraName_.vdb5) is created in 
in the loaded folder. If more than one camera folder is below the loaded folder, the camera name is 
the camera containing the image file with the earliest Modified date. Epoch/Site Name and 
CameraName are as defined relative to the folder containing images in Options. This database should 
not be deleted. 
 
Progress bars are shown for long-running operations, but the estimated run duration may not be 
accurate. Storage speeds strongly affect processing times, so any external storage should have a high 
access speed. Solid state drives generally have faster access speeds than magnetic drives. 
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Reviewing Camera Trap Data  with CamTrap Pro 
Camera traps may be used in a wide range of purposes including feral animal monitoring, species 
monitoring, density estimation, and game detection. They may be located in highly accessible areas, 
where scenes may frequently include vehicles and humans, or off-track where moving objects are 
much more likely to be animals (or birds). Baits (peanut butter, sesame oil or carrion) may be used to 
attract animals into the camera scene. Multiple cameras are usually deployed. 
 
An indicator of the presence of animals in a baited camera trap is to examine the cumulative time 
profile of all the images. As animals often spend some time moving around the bait, the camera is 
triggered multiple times with a very short interval between images. Profiles of image count as a 
function of time and the same profile with visually assigned animal detections marked in red (shown 
by checking Analysis->ShowTagged) is shown below: 

 

 
Figure 9 Image count vs time over 7 days (top) with one or more animal detections shown in red (bottom) 

It may be seen that animal detections are associated with a rapid increase in image count over a short 
period appearing as a vertical step, and that almost all camera triggerings are due to the presence of 
an animal.  
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A plot for a different data set over a similar period with mainly false triggerings, and animal detections 
shown in red, is shown below:  

 
Figure 10 Image count vs time over 7 days with a single animal detection shown in red.  

This data set (from a baited camera) only recorded a single animal over 8 images out of 5000 collected 
over a 7-day period. The animal was not attracted to the bait. Most triggerings were from moving 
vegetation or changing shadow areas. Triggerings were less frequent at night, giving rise to the 
stepped profile. 
 
A data set from a single day using a non-baited trap is shown below: 

 
Figure 11 Image count vs time over a single day, with animal detections shown in red.  

As non-baited traps only record animals passing, detections are less distinctive amid false triggerings 
from moving vegetation or shadows. Few images of animals are recorded. The step shown at 0900 hrs 
is from multiple triggerings when an animal passed very close to the camera, but the incomplete and 
unfocussed view meant that the animal could not be identified. 

Data Required from Processing  
Data required from a camera trap data set is the species of animal detected, and sometimes the 
frequency of detection, or the identity of the animal. This data can be obtained by inspection of 
individual images using built-in computer facilities, and then adding metadata (usually as tags) to 
indicate the presence of an animal in an image. This process is very labour-intensive and without a 
large and competent volunteer labour force it is not an option, especially when a single camera may 
record thousands of images in a single day. Automated methods using machine learning (such as 
Megadetector) provide an alternative. The implementation of Megadetector in CamTrap Pro only 
identifies images containing animals ς species labelling must be done manually, or a species-specific 
classifier can be used. 
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Using CamTrap Pro to Examine Camera Trap Data  

Window Management  
Application windows can only be moved by clicking and dragging in the top part of the screen coloured 
in light yellow as shown below: 

 
However, this part of the screen may be hidden if a window is dragged upwards. To make it visible, the 
cursor should be moved over the bottom boundary of the window until the cursor changes to a 

vertical double-headed arrow:  Clicking and dragging downwards will then show the top part of the 

window. 

Loading Data 
Camera trap data is usually contained in one or more folders per camera or site with filenames which 
include a sequence number in the manner of images from digital cameras. There may be multiple 
folders for the same camera corresponding to different time periods or different locations. Camera 
folders are usually the parent or grandparent folder of the data files. The time period over which 
images below a folder is known as the epoch and is usually the folder containing the camera folders. 
Either of these can be selected in the Options screen. The data filenames usually contain a sequence 
number, and may include a constant string or a representation of the date on which the image was 
taken. The date on which the image was taken is often stored in one or more of the EXIF date fields 
(Date/Time, Date/TimeOriginal, and Date/TimeDigitized). One of these dates is shown in Windows File 
Explorer as the image date. The file Modified date will be the same as this date unless the file has 
been processed in some way. Any folders containing images to be processed should not include the 
string .jpeg or .jpg in their name, as this may cause external programs such as AddaxAI to crash. If file 
Modified dates are to be changed, files should not be read-only. 
 
Camera trap data from wildlife projects is usually in the form of JPEG images, with image sizes of up to 
tens of megapixels. Modern camera traps will also record short video sequences when triggered by 
motion, often in AVI or MP4 format, but video files use much more camera storage space than images 
and a rapid sequence of images can provide similar information. CamTrap Pro will automatically 
extract frames from video files as a sequence of JPEG files, which can then be displayed and 
processed. If AddaxAI is used to process data extracted from video files, only image files created from 
the videos should be processed. 
 
Pre-set text strings should be created to include the names of all animals expected to be detected. If 
individual animals are to be identified, specific names should be added (eg Goanna Rex). Unexpected 
animals may be added to pre-sets during inspection. 
 
The File menu of CamTrap Pro is shown below: 

 
Figure 12 File Menu 
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After Opening or Re-opening a folder, a screen is shown allowing a subset of camera folders to be 
processed where there is more than one camera folder below the selected folder: 

 
Figure 13 Multiple camera folder screen 

Clicking Cancel aborts the loading process and clicking Yes allows camera folders to be selected from 
the screen below. The first camera in the list is selected by default. The menu option Next Camera 
(shortcut Ctrl-N) shows files in the next camera folder if a single camera is selected. 

 

Figure 14 Camera Data Selection Screen 

The File count in each camera folder is shown in brackets after the name. Either the Parent of 
Grandparent of the image files can be selected as well as the camera name. Data may be grouped by 
epoch of recording and then by camera or site. A site may use the same camera for a number of 
epochs, or different cameras. If data is grouped by epochs, a view of the data by camera can be 
created via the Re-order button in Pre/Post Processing screen.  

Open Folder/Re -open Folder  
To load files from a folder, the option File-Ҕ hǇŜƴ CƻƭŘŜǊΧ ǎƘƻǳƭŘ ōŜ ǎŜƭŜŎǘŜŘ ŀƴŘ ǘƘŜ ŦƻƭŘŜǊ 
containing the files browsed for. The menu option File->Re-open Folder opens the last loaded folder 

again. If the data is on a removable USB drive, the top level folder (eg F: ) may contain an 

inaccessible System Volume Information folder. If this is present, data cannot be loaded using the 
drive letter as the opened folder. Data should be copied to a folder within the top folder of the drive in 
this case. If the loaded folder contains video files, frames will be extracted from each file and saved in 
the folder containing the video file with name Video_File_vx_nnn.jpg, where nnn is the frame number 
of the video and Video_File the filename of the video file. The number of frames (Files Per Video) 
extracted is set in the Advanced tab of the Options screen.  
 
If no folder has been previously selected, a browse screen is shown. After opening the folder, a screen 
similar to that shown below will appear if there is only one camera folder below the selected folder: 
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Options ɀ General  
The Options tabs General and Advanced are shown below via File->Options: 

  
Figure 15 Options ς General Tab 

File Order in Folders 
File Order in folders specifies the ordering of files within the selected folder as Path, Date Taken 
Modified Date or Folder->Modified (default). The default option orders files by Modified date within 
camera folders. Modified date may be changed by checking the Change Modified Date on Load 
checkbox, using options specified in the Change Modified Date Options box.  
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Detection and Name As Tag 

 
Figure 16 Detection Category Grid 

The Detection grid is used to show detection category names, the number of files with detections in 
that category (after using Machine Learning) and whether highlight detections with the category 
within the range specified in Confidence Range are used, and whether category names are applied as 
tags. The Megadetector classifier uses IDs 1,2 and 3 for animals, humans and vehicles respectively. 
Classifiers which identify particular species will have their own numbering scheme as shown above, 
which is defined in the detection_categories node of the JSON file. The category name is shown in the 
2nd column (CategoryName), the number of detections (Count) in the category in the 3rd column, 
whether to highlight detections with that category in the 4th column (Use), and the option to use the 
category name as a tag is set with a checkbox in the 5th column (NameAsTag). The Use checkbox above 
the grid sets or clears the Use parameter for all categories, and the Name as Tag checkbox does the 
same for the NameAsTag parameter. If one or more CategoryNames have NameAsTag set, the 
CategoryNames will be added as described in Using Pre-set Values for Tags on page 51. 
 
The Set To Default button restores the default categories of animal, vehicle and person used by 
Megadetector. Load Categories loads the categories defined in a JSON file  
 
The Count column is empty before any JSON file is loaded. After one is loaded, the number of 
detections with a particular category in the file are shown. 

Filter  

 

Highlights Only 
If this is checked, only files which have had highlights created will be loaded. If highlighting from 
Megadetector is used, these are files where there has been a detection with a confidence between the 
upper and lower bounds specified. The highlight categories shown in the text box below Categories to 
Show will be shown, followed by the category ID used in the metadata. The list of values can be shown 
by clicking in the text box and using the page up and page down arrow keys. The highlight categories 
shown can be changed by clicking the Change button. If a refining classifier with species names is used, 
the list of selected categories can be set to exclude any unidentified or unknown categories or any 
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common misidentifications. The Min Size(%) value can be set to select only image with a highlight box 
whose area exceeds the specified fraction of the image area. It is useful where false detections are of 
very small features. 

Categories to Show 
The screen below shows the selection of highlight categories to be loaded via the Change button 
beside the Categories To Show text box; 

 
Figure 17 Categories Selection screen 

Min Size 
This combo box specifies a minimum detection size as a percentage of the entire image for the 
selected categories to be shown. It is useful where spurious detections are small. 

Non-Highlights Only 
If this is checked, only files which have not had highlights created will be loaded. These will generally 
not contain images of animals, but will contain images of animals where the detection confidence is 
outside the range specified. 

Below Threshold Only 
If this is checked, only files with at least one detection below the lower threshold will be loaded. If any 
animals of interest are shown, the lower bound of the detection confidence range should be 
decreased. However, the number of false detections will increase. 
 

Folder Paths 
If this is checked, the text box below specifies a string used as a Regex which must match the path of a 
file if the file is to be loaded. This allows files from particular folder to be excluded. 

Date Range (Days) 
If this is checked, only files with Modified dates between From and To (in whole days) are loaded. The 
time part of any date/time entered is ignored. If To is empty, it is assumed to be 1 day after the From 
date. If specified, the To Date must be after the From Date. Examples of acceptable date formats are 
shown below: 
01/10/2022 
1/10/2022 
1 Oct 2022 
Oct 1, 2022 

None 
This option loads all files in the selected folder. 
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Skip Files Less than N secs Apart 
This option skips loading for files whose Modified date is equal to or less than a specified number of 
seconds after its predecessor. This option can greatly reduce the number of files loaded, as there a 
generally a number of images showing the animal recorded as the animal moves within the camera 
detection area. The value for image count and duration will be affected, but not the number of 
detection events, which occur when an animal appears in one or more images separated by less than 
the Gap length specified in the advanced tab. The reduced data set can be copied using Copy Loaded 
and then processed using machine learning. The reduced number of files will speed processing. As 
detection events are used to estimate species abundance, using this filter setting will not affect 
abundance estimates. However, closely spaced images may assist in animal identification and using 
this option may result in less accurate species identification/ 
 

Load Every Nth File 
This option reduces the number of files loaded by decimation using the selected factor and is useful 
for loading a sample of file to check start and end times for camera data for large data sets. 

Tagged With 
This option only loads files which have had a tag applied. The default * value loads files with any tag. 
Tag names can be matched by adding the tag name (or names) in the text box to the right of the radio 
button. If Exact is not checked matching is done via Regular Expressions, so multiple names can be 
matched if separated by a | symbol, and partial matching is also possible. A tutorial on Regular 
Expressions can be found here. If Exact is checked, an exact match is required. 

Exact 
If Exact is checked, an exact match between the tag and the supplied string is required to load the file. 

Comments 
This option only loads files which have had a comment added if * is in the search box to the right of 
the radio button. If any other string is present in the search box, only files with comments containing 
the string are loaded. Matching is done via Regular Expressions, so multiple names can be matched if 
separated by a | symbol, and partial matching is also possible. A tutorial on Regular Expressions can be 
found here. 
 

From Files 
This option qualifier applies only to the Tagged With and Comments options. If unchecked, the tag or 
comment is retrieved from the TagDB database. If checked the tag or comment is retrieved from file 
metadata. This option is much slower. 

Day Only 
If From Flash is checked, the image Flash metadata is extracted and if the string Not Fired is present, 
the image is assumed to be recorded during the day and is loaded. If it is not checked, a 5x5 thumbnail 
image is created and if at least one pixel has red, green and blue pixel values which differ by more 
than 4 it is assumed to be non-monochrome and loaded.  

Night Only 
If From Flash is checked, only images where the Flash metadata does not contain Not Fired or is 
absent are loaded. If From Flash is not checked, only images with monochrome thumbnails are loaded. 
Night images in vegetated environments contain far fewer false triggerings than day images. 

Use Flash Status 
If checked, image EXIF Flash metadata is used to determine whether the image was taken during the 
night or during the day, as the flash is fired if there is insufficient light. If unchecked, thumbnail 

https://regex101.com/
https://regex101.com/
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analysis is used. The checkbox is only enabled if Day Only or Night Only are selected. Most cameras 
record the Flash status and the processing using this option is faster if day/night status is determined 
from metadata rather than thumbnail analysis. However, not all cameras record Flash status and the 
Flash status may be incorrect. 

Folder Paths 
Data sets may include hundreds of folders for different combinations of cameras, locations and 
epochs. This functionality allows filtering of folder names to only include folders containing specified 
text when the check box is ticked. Matching is done using Regular Expressions, so multiple match 
strings can be added if separated by a | symbol. 

Highlights  

 

Change Modified Date on Load 
Changing the Modified date to reflect the actual date and time at which the image was recorded is 
useful if the count vs time profile is used and is required if highlighting is to be performed using the 
Changes or Sequences options. It is not required if machine learning algorithms are used to detect 
animals in images and only the number of images in which animals appear is required. 
 
If the checkbox is checked, one of the following options can be selected. After loading with the 
checkbox checked, it is automatically unchecked. 

 

Option Description 

Add Increment 
from Date/Time 

Sets the Modified Date to the specified date plus the time difference 
between the current image Modified date and the first image loaded. If 
there is a gap between the date of the first image and the start of the 
recording epoch, images before the start of the recording epoch should 
be deleted via the Check Times Pre-Processing screen. This option can 
correct for camera time not being set to the time at which the camera 
was first triggered as it preserves the time interval between images. 
Date Formats can be like any of the following: 
01/10/2022 22:35 
01/10/2022 10:35 PM 
1/10/2022 7:35 AM 
1 Oct 2022 10:35 PM 
Oct 1, 2022 10:35 PM 
This option is disabled if Use Epochs is checked. 

Use Epoch Check to use a different specified date if the Epoch folder matches the 
Epoch name entered via Set Epoch and the Modified date is earlier 
than the Start Date of the Epoch or later than the End Date. Allowable 
date formats are as above. Epoch names and starting dates are 
specified by clicking Set Epochs. 

Shift Add or subtract a number of seconds from the existing Modified Date. 
Calculate button shows web site for calculating interval between 2 
times. 

Date Taken/OCR Set Modified Date to EXIF or Reconyx Hyperfire directory metadata 
fields Date/Time, Date/Time Original or Date/Time Digitized, or File 
Modified Date in the File metadata directory. If neither of the 
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preceding metadata fields are found. If this does not exist or is invalid, 
use OCR on a region of the image as described below. 

Date Taken Set Modified Date to EXIF or Reconyx Hyperfire metadata directory 
fields Date/Time, Date/Time Original or Date/Time Digitized, or File 
Modified Date in the File metadata directory. If this does not exist or is 
invalid, the Modified date is unchanged. If further change to the time is 
required, the Shift option can be used after Date Taken. 

Set from OCR on 
Image Region 

Get Date from OCR on region of image where date is shown. The 
region is selected using the Set Region button. Failed date extractions 
are logged in file SetDateFromImageFails.txt which is created in the 
loaded folder.  

 
If this option is checked after files have been loaded in Modified Date order, the option to re-load the 
files to reflect the changed order is shown. The checkbox is unchecked after loading. 

Set Region 
Clicking this button allows selection of a file within which the date is shown as below: 

 
Figure 18 Screen from which to select date region 

Clicking and dragging and releasing shows a red box, which should contain the date region. The date 
region should allow for the increase in length caused by multiple digit values in the date string and 
should generally include the region up to the first non-date character as shown above. The top and 
bottom of the region include all of the data digits. 
 
The colour of the background (black or white) should be specified, and the format of the year, month 
and day parts of the date string. 
 
Clicking OK transfers the pixel dimensions of the date area to the Options screen. These values can 
then be edited. The Top LH Y value should not be less than zero. 

Set Epochs 
This screen is accessed via the Set Epochs button. It allows definition of the epoch name and range of 
allowable date/times, either by entering rows one at a time or pasting epoch with each epoch name 
and on a new line with name, start date and start date limit separated by a tab character. The Start 
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Date Limit must be equal to or after the Start Date. If the Modified date/time of a file loaded is outside 
this range, Modified dates are shifted to use the Start Date specified plus the difference between the 
Date Taken of the first image recorded by the camera and the Date Taken of the current image. This 
facility is used to make the Modified dates of the loaded files correspond to the date at which the 
photo was actually taken, which may not be the time recorded in the Date Taken metadata. Adjusting 
the Modified dates allows tag summary data to show the actual time at which the tagged image was 
taken. Using Set Epochs allows all camera data for an epoch to show the same time. 
  
The Epoch name must exactly match the name of the Epoch folder. If the Epoch folder name is not 
found, the option to continue leaving Modified date unchanged or to stop loading is presented. The 
Modified date is set to the specified StartDate plus the difference between the Date Taken of the file 
and the Date Taken of the first file. Epoch names and start times can be added, removed or edited. 
Allowable date formats are as defined in Change Modified Date on Load. Update should be clicked 
before closing the screen if data is not added by pasting. The Epoch name is the name of the folder 1 
or 2 levels above the camera folder as defined by Epoch Levels Above Camera. 

 
Figure 19 Epoch name and start date definition 

 
 

Show Existing Highlight Boxes from Metadata  
Checking this checkbox examines metadata for all loaded files to see if highlight data is stored and 
allows display of highlight detection boxes without reloading a JSON file. However, checking this 
option slows file loading considerably. 

Camera/Site and Epoch Folders 
Camera trap data from multiple cameras is usually stored as a folder tree where the camera name (or 
site name) is the folder name containing the images (parent) or the folder above this (grandparent). 
The folder defining the time period within which data below it collected is known as the epoch, and is 
the folder above the camera name or the folder one level above this depending on the setting of the 
Epoch Folder combo box. The value can also be set in the Pre/Post process Files screen. 
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Options ɀ Advanced 

 
Figure 20 Options - Advanced Tab 

Colours 
The colours used for highlight boxes and annotation lines and points in the time profile can be set 
from this area. 

Summary Date Grouping 
Tag Summaries can be presented over a time interval of a day, a week (with the week starting on the 
day as defined in the Summary Grouping box) or over all times. 

Show In Title bar  
These checkboxes control what information about the displayed file is shown in the title bar above the 
image on the main form. As file names may be very long if highlight data is stored in the file name, it 
may be useful to omit this if viewing only highlighted data. 

Only Show Detections with Used Categories 
If this option is checked, only detections from categories flagged with Use (in the General tab) will be 
stored. Otherwise, all detection are stored. Checking this option can speed processing where large 
numbers of tags are generated automatically. 

Rebuild Tag Summary After Apply 
Checking this option rebuilds the tag summary after each tag is applied. This may take some time if a 
range of images have a tag applied to them via Batch Apply. In this case, this option should be 
unchecked and a tag summary generated after all images have been tagged. The Tag Summary and 
Occurrence appears as shown in Figure 103 on page 79. 



 

 29 Aleka Consulting 
  www.alekaconsulting.com.au 

Show Tag Text on Count vs Time 
This option displays the text of tag beside the image highlighted in red if Show Tagged is selected in 
the screen shown in Figure 76. The display is as below: 

 

Only Set Tags from Presets 
If checked, tags can only be applied from the list shown in Presets. Tags cannot be entered or edited in 
the Tag box on the main screen. 

Store Animal Counts in Images 
If checked, the minimum and maximum number of animals appearing in a detection event is stored in 
the Tag Summary data. Checking this option slows processing. 

Add AutoTags to Existing Tags 
If checked, tags generated from Categories via the Name as Tag settings are added to any existing tags 
applied to tags already applied. This option is useful for comparing the performance of machine 
learning classifiers with manually applied tags. However, it slows processing. 

Add Mark String to Tags 
If checked, the mark string specified is prepended to any existing tags on load. This allows these tags 
to be excluded from the Clear operation executed from the Pre/Post Process screen. The action is 
implemented when data is reloaded after checking this option. Processing will be very slow as tags 
have to be retrieved from all files. The mark string should not be present in any tags. 

Store Detections 
If checked, detection details are stored in TagDB and are used for creating a Detections plot as 
described on page 89. Processing of JSON files is faster if this checkbox is not checked. 

Auto-refresh  Data Points 
If checked, all data points on the Count vs Time Plot are refreshed after applying a tag. The refresh 
process can be stopped by clicking Cancel. 

Suppress Camera Labels 
If checked labelling of the data points where camera changes will be suppressed. This may be 
necessary if the application becomes unresponsive when displaying the camera name where data 
from one camera ends and another begins. This may occur if the camera names overlap on the screen. 
The wait cursor will appear periodically in this case. Enlarging the screen area or suppressing camera 
labelling will fix this problem. 

Detection Change Interval (Sec) 
This value is the number of seconds between successive highlighted images below which a tag is not 
applied if Name as Tag is selected. It can be thought of as the minimum time between the detection of 
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different animals. It prevents repeated tagging of images within a sequence generated when an animal 
moves across or within a camera detection region. The camera may be triggered if only part of the 
animal is visible in the image or the animal has a different appearance through movement such as 
grooming. These changes in the animal image may result in machine vision misidentifying the animal 
in that image if a species-specific model is used as shown below: 

 
Figure 21 After species-specific machine vision with Detection Change = 0 showing misidentifications 

Using the SpeciesNet machine vision model, the series of images between 16:30 and 18:20 on 
11/12/2022 contains a large number of different animals. Inspection of the images indicates that only 
a fox is present. 
 
Figure 22 shows the same data using the default value of 600 seconds so that a tag is only generated 
for an image with a detection with the previous detection more than 600 seconds earlier. 

 
Figure 22 After species-specific detection with Detection Change = 600 seconds 

The mis-identifications in the 2000 image sequence between 16:30 and 18:20 have been removed.   
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For camera traps using carrion as bait in urban or peri-urban areas, many images of carrion-eating 
birds or foxes may be recorded, sometimes in groups separated by a few minutes. Whether these 
groups record different individuals is difficult to determine. 
 
Optimal values for this setting depend strongly on the expected animals or birds present in the 
monitored area. The default value is 600 seconds. A value of 0 will create tags for all files with 
detections (if Name as Tag is selected). 

Max Gap (min) Creating New Detection Event 
This value specifies the time interval in minutes between successive images from the same camera 
with the same tag above which a sequence is regarded as distinct from its predecessor. If the gap is 
greater than this value, the sequence before and after the gap are regarded as different detection 
events. The default value is 10 minutes (600 seconds). 

Max Gradient Interval  
The average gradient of the count vs time profile (in images per second) is shown to the right of the 
sequence when right clicking on point as shown below.  

      
Figure 23 Count vs Time Gradient with no animal present (left) and with animal present (right) 

Where a point is separated in time from its successor by more than the value specified, it does not 
contribute to the average value. Points contributing to the average value are shown in brown. A 
gradient value is not shown if there are no points contributing to it. 
 
The gradient value is useful in determining whether the camera is being triggered by a moving animal 
or by moving vegetation. Gradient values are generally higher if an animal is causing the camera 
triggering.  

Gradient Points  
The value set in this box sets the maximum number of points over which the average gradient is 
calculated. Points may not be used if the time interval exceeds the threshold set in Max Gradient 
Interval. 

Truncate Camera Name to Length 
The camera name will be truncated to the specified number of characters if the length is less than the 
specified value. 

Truncate Epoch to Length 
Epoch will be truncated to the specified number of characters if the length is less than the specified 
value. 
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Highlights  

Store in File Metadata 
If checked, the category, confidence value and corner co-ordinates of detections in the defined range 
are stored in the file name. The detail of each detection is added as a comma-separated string 
between pairs of sequential underscore characters, giving file names of the form shown below: 
 
RCNX0118__0,1,0.968,0,0.116,0.141,0.735,__.JPG 
 
Parameters of the detail are as follows: 

Parameter Description 

1 Zero for machine vision detections, 1 for manually defined 

2 Detection category code (Integer) 

3 Detection confidence (0-1.0) 

4 Detection box Top LH X as fraction of image width 

5 Detection Box Top LH Y as fraction of image height 

6 Detection Box Bot RH X as fraction of image width 

7 Detection Box Bot RH Y as fraction of image height 

 
If the file name with detection metadata added exceeds 260 characters in length, detection metadata 
will be removed until the length is less than 260 characters. A warning will be logged if no metadata 
can be added to the name, but processing will not stop. Warnings can be viewed via the Errors top-
level menu item. 

Use Only Highest Confidence 
If Use Only Highest Confidence is checked, only the single detection with the highest confidence is 
stored. If it is not checked, multiple detections in the same image may be stored, sometime resulting 
in excessively long file names, is metadata is stored in the file name. Note that multiple animal 
detections will still be stored and be visible in Tag Occurrences if this option is checked. Note that the 
Detections grid shown by Analysis->Detections maps all detections within the defined confidence 
range, not just the highest confidence detection. If Use Only Highest Confidence is selected, the 
detection box corresponding to the selected grid cell may not appear on the main screen. 

Files Per Video 
This value determines the number of JPEG files created (at equal time intervals) from loaded video 
files. Files are created from video frames, starting with the first frame. For a video are stored at 30 
frames/sec the default value of 10 creates 30 JPEG images spaced by 0.33 secs for a 10 second video 
sequence. The created JPEG file has the name Video_File_Name_vxnnn.JPG where nnn is the frame 
sequence number. The Modified date of the file is the Modified date of the video file incremented by 
the frame sequence number multiplied the time between frames. 
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Pre/Post Processing  
The File->Pre/Post Processing screen as shown below is used to perform a number of pre- and post-
processing functions: 

 
Figure 24 Pre/Post Processing screen 

Clear Entities  
The Clear button allows one or more of detections, tags and comments to be cleared from loaded 
images, depending on whether the corresponding checkbox is checked. 

Tags 
Tag data stored in the Windows Tag metadata field and tag data store in TagDB is removed via this 
button. If Only Unmarked is checked, only tags which to not contain the mark string defined in Options 
are removed. Processing is much slower if this option is checked. 

Detections 
Any detection highlight data stored in the file name or the Windows Authors field of file metadata is 
cleared via this button.  

Delete Dups 
If checked, any files existing after detection metadata has been removed from the file name is deleted, 
otherwise a sequence number is added to the file name. 

Comments 
Comment data stored in the Windows Exif metadata field XPComment and in TagDB is removed. 
 

Check for Corrupt Files 
Corrupt JPEG files may appear in the loaded data and cause the program to crash or behave 
unpredictably. Clicking the Check button with Delete checked will remove these files and reload the 
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data. The Pause checkbox allows processing to pause if a corrupt file is found. Zero size checks for files 
of size zero, which is a frequent form of corruption. The zero-size check is much faster than alternative 
which attempts to read the entire file. A list of corrupt files is created in the loaded folder with name 
CorruptFiles.txt, and can be viewed if Zero Size is checked. 

Camera 
The Info button in the Camera box shows the epoch over which images were recoded, the camera 
name and manufacturer, the number of files in the camera folder, the Modified and Date Taken dates 
of the first and last files in the camera folder, and the duration of the time interval between Modified 
dates of the first and last images as shown below. Data must be loaded in Folder->Modified Date 
order the Options screen. 

 
Figure 25 Camera Data Information 

Column names can be shown in full by hovering over the column header. CameraName is the name of 
either the grandparent or parent folder of the file containing the images. The Epoch of images in the 
Camera folder is the folder either 1 or 2 levels above the Camera folder as selected by the Epoch 
Levels Above combo box in the Pre/Post process screen. Duration is the difference between the first 
and last Modified dates. Modified dates can be changed in the Options screen, but Date Taken is not 
changed. This is the date/time recorded by the camera, which may not be the actual date on which 
the photo was taken. Date Taken may start from a factory default which may be years before the 
actual date, or be incorrect through data entry problems. 

Closely Spaced Tags 
Clicking the Remove button removed tags from images where the preceding tagged image has the 
same tag and has a Modified date less than a Detection Event duration (default 10 minutes) before. 
The Detection Event duration is set in the Advanced tab of the Options screen as Max Gap Creating 
New Detection Event. It is used if tags may have been applied to images showing the same animal 
spaced by less than the Detection Event duration. It should not be used if the Tag All Images options 
on the Presets screen is selected. 

Folder Tree 
This button creates a file showing the folder structure beneath a selected folder and whether that 
folder contains any JPEG files. The file is displayed by Notepad on completion. This display is useful for 
ensuring that the folder structure is amenable to automated analysis with CamTrap Pro 

Re-order  
This option is used to reorganise data grouped by epoch and camera to be grouped be grouped by 
camera only. Folders with the camera name (optionally truncated) will be created in a folder named 
Shortcuts which is created in a selected folder. Within each camera folder, shortcuts to the camera 
folder for each epoch will be created as shown below. 
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Figure 26 Shortcut folders created to display data organised by Epoch 

Shortcuts to folders are processed in alphabetic order, so the Epoch names should be changed to be in 
the desired order in order to create profiles such as the one shown below. Where numbers are 
included in the Epoch name, shortcut names should be padded with leading zeros. Epoch rather than 
camera changes are shown on the plot as shown below: 

 
Figure 27 Count vs Time profile from shortcut folder 

Note that if shortcuts are created on an external drive mapped to a drive letter, the shortcuts will only 
ǿƻǊƪ ƛŦ ǘƘŜ ŘǊƛǾŜ Ƙŀǎ ǘƘŜ ǎŀƳŜ ƳŀǇǇŜŘ ƭŜǘǘŜǊΦ LŦ ƛǘ Ƙŀǎ ŎƘŀƴƎŜŘΣ ǘƘŜ ƳŜǎǎŀƎŜ άbƻ ƛƳŀƎŜ ŦƛƭŜǎ ōŜƭƻǿ 
ǎŜƭŜŎǘŜŘ ŦƻƭŘŜǊέ ǿƛƭƭ ŀǇǇŜŀǊΦ ¢ƘŜ ŘǊƛǾŜ ƭŜǘǘŜǊ ǳǎŜŘ is shown in the name of a file created in the 
Shortcuts folder. 

Check Seq 
This option is used to detect when the image sequence number embedded in the file name increases 
by more than one in sequential files, indicating that a file is not present. The distribution of time 
intervals (in seconds) between successive images is also shown. The filesystems used on the SD cards 
containing the camera images do not usually record times to an accuracy of less than 1 second. A text 
file listing is created in the loaded folder with the name MissingFilesAndIntervalDistrib.txt and this file 
is shown in Notepad on completion. 

Remove Detections with Confidence Below 
When processing large data sets from multiple cameras, there may sometimes be large numbers of 
low-confidence detections in the Tag database. If this is the case, the display of all detections may be 
very slow. It can be sped up by removing the low-confidence detections from storage. Once this has 
been done the lower limit of the detection range will be the maximum of the value set and the value 
specified in the text box (default 0.1). 

Set TaggedFiles to File Tags 
When tags are applied, tag metadata is sometimes set in the file but the file path, tag name and 
modified date are not set in the TaggedFiles table of TagsDB. Clicking Set checks that a tag string in 
loaded files metadata also appears in the TaggedFile table. TaggedFiles data is used in preparing Tag 
Summaries. 
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Edit By Time 
Pre-processing may be necessary to obtain correct recorded dates. If no date/time is set on the 
camera, the first image date/time recorded will be the default date/time (often the date of camera 
manufacture) or the date/time of the last use of the camera. The time interval between images will be 
correct. In order to correct this, the date/time of the first image can be set in Options and the 
Modified date of subsequent images set to this date/time plus the date/time difference between this 
image and the first image. If the first few image use the default date/time and later ones use the 
correct date time, these default date/time images should be removed to ensure that the count vs time 
profile is comparable with cameras with the correct date setting. This operation can be performed via 
the Edit By Time button. This allows deletion of images within a selected time range via the count vs 
time profile for the loaded files as shown below: 

 
Figure 28 Edit by Time screen 

If Delete is clicked after dragging a box around points to be deleted, images corresponding to points 
within the box will be deleted after confirmation. Images corresponding to points can be viewed by 
right-clicking on the point. 

Resample 

 
Figure 29 Resample Options 

This option allows resampling and adjusting of the loaded images to pixel dimensions either 1x, 2x or 
4x smaller, depending on the Factor setting. The contrast and brightness attributes of images can be 
adjusted via the Contrast and Brightness values, which must be between 0.5 and 2.0. Increasing the 
values above their default values of 1.0 increases the attribute, and reducing it to less than 1.0 reduces 
it. 
 
LŦ ŀ ǎǘǊƛƴƎ ƛǎ ǇǊƻǾƛŘŜŘ ƛƴ ǘƘŜ Ψ/ƻǇȅ ǊŀǘƘŜǊ ǘƘŀƴ ǊŜǎŀƳǇƭŜŘ ŦƛƭŜǎ ǿƛǘƘΩ ǘŜȄǘ ōƻȄΣ ŦƛƭŜǎ ŎƻƴǘŀƛƴƛƴƎ ǘƘŜ ǎǘǊƛƴƎ 
in their path are copied rather than resampled and their attributes are unchanged. This allows 
selective resampling. If Full Path Below Folder is unchecked, the subfolder identifies the camera folder 
and is either the name of the parent folder, or the name of the grandparent folder followed by the 
parent folder name of the current image file. If the checkbox is checked, the entire path of the folder 
(without the source drive letter) containing the file is appended to the selected drive or folder and is 
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the destination folder for processed files. Any existing folders or files in the destination folder are 
deleted. 
 
Files containing a specified string in their path can be excluded from resampling and are copied to the 
destination folder unchanged. 
 
Resampling speeds up certain CamTrap Pro operations, such a slideshow display and detecting 
changes between images and increases the speed of machine learning processing by applications such 
as AddaxAI. Resampled files have only the EXIF fields Date Taken, Date/Time Original and Date/Time 
Digitized copied from the loaded files. Adjusting contrast or brightness may improve the performance 
of machine learning algorithms in detecting animals. 

Rename Folders Below 
This option is used to change the name of folders below a selected folder to include the name of their 
parent folder in their name. The folders which have their name changed are one level up from the 
bottom of the folder tree. The folder tree should have all image files at the same level. An example of 
the changed name structure is shown below: 

 
 

 
Figure 30 Folder Tree before (Top) and after (Bottom) renaming 
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It is used when there are multiple cameras per site which need to be distinguished if existing camera 
names (for example, Left, Right and Centre) are repeated at different sites.  

Rename File to Sequential Numbers 
This option is used to change the file name to the position of the file in the loaded sequence. It is used 
if file names do not contain sequential numbering. 
 

Project Details  
 The name of the project and the site over which cameras are deployed can be specified via the File-
>Project Details option, which shows the screen below: 
 

 
Figure 31 Project Details screen 

Project Name is the name of project (eg Deer Control) and Site Name is the name of the group of 
cameras whose data is being processed. All parameter are optional, but Map functionality will not be 
available unless a camera location file is specified. The camera location file is a tab-separated text file 
with three columns of data per line. The first column should contain the camera name (eg A_M01). 
The second and third columns should contain the latitude and longitude of the camera in decimal 
degrees. 

Consolidate TagDBs 
The functionality consolidates Tag Summary data from all TagSummary (TagDB) databases in the 
selected folder, which is accessed via the Browse button below: 

 
Figure 32 Consolidate Tag Summary Screen 

TagDB files have a name starting with TagDB, followed by the Epoch/Site name and a camera name, 
separated by underscores. After selecting the folder, and clicking Rebuild (to rebuild or create the 
consolidated tag summary), a confirmation screen is shown: 

 
Figure 33 Confirmation screen for rebuilding or creating consolidated summary 
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If yes, is selected, data from TagNames, TagOccurrences and Tagged Files from each of the TagDB files 
is consolidated in a new database called MasterTagdb.vdb created in the selected folder. This process 
may take some time. After completion, the summary will be shown in the same way as for individual 
Tag Summaries: 

 

 
Figure 34 Consolidated Tag Summary Reports 

If a folder has already been selected, a prompt to confirm showing data is shown. If yes is selected, 
prompts to rebuild or view the Stats and Freq reports are shown. If these have already been created, 
view can be selected, as rebuilding may be quite slow. 
 
Right-Clicking on Species tags on the Freq display (lower right) allows images from all epochs to 
displayed and the tags changed if required. Showing Count vs Time allows images before and after the 
selected tagged image to be inspected via the View Image button. 
 
 Note that the tag Summary must be rebuilt after this to show changes in the reports 
  

Copy Loaded 
The menu item File->Copy Loaded copies files or detection regions to a destination folder, optionally 
preserving the folder structure via the screen below: 

 
Figure 35 Copy Loaded Files Screen 
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This option allows saving of a copy the data after applying any of the filters specified in Options. Note 
that the TagDB from the source file is not copied to the new folder. If filtering by tag on copied data is 
required, From Files should be checked. 
 
If Crop Detections is checked, the input image is cropped to the detection box (if both its width and 
height exceed 1 pixel) and the file given the name of the category of the detection, with a numeric 
suffix if there is one more than one detection in that category. The path to the image from which the 
crop was taken is stored in the Title field. An example of the display of folder content from this option 
is shown below.  

 
Figure 36 Display of images cropped to detection regions 

These displays are useful to determine the efficacy of species-specific classifiers. In the example 
above, possums are misidentified as cats. 
 
If Tag as Name is checked and Tag is not empty, the tag is used as a file name (with any illegal 
characters replaced by _) rather than the detection category name. Filtering loaded data for the 
presence of any tag value (via the Tagged With option described on page 24) allows a quick check of 
the tag application process. 
 
¢ƘŜ ƴŀƳŜ ƻŦ ǘƘŜ ŦƛƭŜ ƛƴ ǿƘƛŎƘ ǘƘŜ ŘŜǘŜŎǘƛƻƴ ǿŀǎ ƳŀŘŜ ƛǎ ǎǘƻǊŜŘ ƛƴ ŦƛƭŜΩǎ ¢ƛǘƭŜ ƳŜǘŀŘŀǘŀΣ ǘƘŜ ŘŜǘŜŎǘƛƻƴ 
confidence value in Subject and any comment applied in Comment. These fields can be displayed in 
Windows File Explorer. 
 
If Keep Folder Structure is not checked, loaded files or cropped images will be copied to the 
destination folder. If a file of the same name is present, the option to add a numeric suffix or replace 
the existing file is presented, unless Crop Detections is selected, when a suffix is always added. 
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If Name From Modified is checked, a prefix consisting of the sequence number (for up to 99,999 files) 
with leading zeroes  added is added to the file name with the prefix reflecting the order in which the 
files were loaded. This ensures that all file names are unique and alphabetic ordering is the sam as 
Modified date ordering. Other processing programs (such as AddaxAI) may process files in alphabetic 
order and using Name From Modified ensures compatibility. 
 
The menu item File->Export Loaded exports loaded attributes to a tab-separated text file that can be 
further processed if required. If data has been loaded, the screen below is shown: 

 
Figure 37 Export Data screen 

The folder in which the file is created is the loaded folder by default but can be changed via the 
Browse button. The default file name is Data For <Site/Epoch>_.txt can also be changed. The Project 
name (as specified in Project Details), Site/Epoch, Camera folder name, Sub-camera folder name, file 
name, Modified date, Tag, Count, Comment and optionally the highlight category (or categories) are 
included. Count is the number of animals which have been tagged. Tag data can be extracted 
internally if tags have been applied with CamTrap Pro or from file metadata if they have been tagged 
using another program. This option is much slower. If multiple tags are applied to image, a separate 
line is added for each tag. The option to display the exported data in Excel is presented once exporting 
is complete, as shown below: 

 
Figure 38 Excel display of exported data 

Processing Data from Multiple Cameras  
Data from multiple cameras can be processed in one pass by CamTrap Pro by selecting the folder 
above the individual camera or site names. File Order in Folders should be set to Modified Date for 
Folder->Modified Dare, and the Modified Date of images should be set to the time at which the image 
was recorded. Incorrect Modified Date values may be due to processing after image capture altering 
the image Modified Dates, or camera internal clocks not being correctly set. If Modified dates are not 
reset, the Count-Time profiles will not appear as shown in the examples, but may have a stepped 
appearance over a short space of time. If the aim of processing is only to detect the appearance of 
particular animals, Modified Dates do not have to be reset, but time durations in the summary report 
will be incorrect. 
 
If multiple folders are present below the selected folder, the screen below appears: 
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Figure 39 Multiple camera data folder screen 

Selecting No treats files as though they were in a single folder, and count vs time profiles are stacked if 
folder order is Folder->Modified or summed as a single profile if order is Modified. Selecting Yes allows 
selection of camera data sets as shown below as multiple folders and displays count vs time profiles 
starting from the origin. 

 
Figure 40 Multiple camera selection screen. 

The bracketed number after the camera name is the number of files in the folder. This is only shown if 
the sorted order of loaded files is Folder->Modified. The values are only reliable if the Modified dates 
of the record the time at which the image was recorded. The name of the TagDB database created in 
the selected folder includes the data site\epoch, and the first n characters of the selected camera 
folder names, as specified in the No. of chars to use in TagDB name combo box. If more than one 
camera is selected, camera names are separated by commas. The option to change the camera name 
folder between Parent and Grandparent is shown. If OK is selected, data from the each of the selected 
camera data folders will be loaded into CamTrap Pro ordered by Modified Date within each camera 
name folder, where camera name folders are sorted alphabetically.  
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Selecting Analysis->Count vs Time, shows profiles for each camera separately as a stack as shown 
below: 

 
Figure 41 Count vs Time Profile of Data from Multiple Cameras 

The name of the camera for each profile can be shown by moving the cursor over a non-horizontal 
part of the line profile. 
 
 
After loading JSON data, each animal detection within the default detection range (currently 0.4 to 
1.0) is marked as a blue highlight dot: 

 
Figure 42 Multiple camera count vs time with animal detections highlighted 

Selecting Highlight->Megadetector->Copy copies all highlighted images to sub-folders of the 
Highlighted folder, where the sub-folder names are the names of the multiple cameras. This data can 
then be loaded into CamTrap Pro for tagging and summary generation. Highlighted images can either 
be ordered within the camera folders they came from or collectively. 



 

 44 Aleka Consulting 
  www.alekaconsulting.com.au 

Tagging by Visual Inspection  
Once the files are loaded, tags may be applied by visual inspection of each image using the Slideshow-
>Play option, which shows all the loaded images in the order selected in the Options screen. (For the 
Camera Trap options, this is Date Taken.) Ctrl-P toggles the slideshow between playing and pausing. 
The time between image displays can be selected in the Options screen or via Slideshow->Interval and 
should generally be 250 msec. If an image takes more than 250 msec to load, as can happen for large 
images, the time interval will be increased to the first multiple of 250 msec greater than the load time. 
If an animal appears in an image, the slideshow should be paused and moved backwards if required 
using the left arrow key. Tags selected from the Presets menu (shown by clicking the Presets button as 
shown below) can then be added to the image, or entered directly if allowed. 
 

 
 
If the same tag is to be applied to multiple files (as will often be the case), this can done via the Time 
Analysis screen 
 

Viewing Data  
 
The Start screen for CamTrap Pro is shown below: 

 
Figure 43 Main Screen after starting CamTrap Pro 

Input data is loaded via the File->Folder option. For single-camera data, the selected folder should be 
the parent or grandparent folder of the image files. For multiple camera data, the selected folder 
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should be above the folder containing all the individual camera data sets. The images must be 1 or 2 
levels below the folder identifying the camera as shown in Figure 7. 

 
Figure 44 Folder Browse screen showing sort order 

The sort order can be changed via the Options screen. Modified or Folder->Modified order gives faster 
operation than Date Taken. If Modified Date is not the same as Date Taken it can be updated from 
Date Taken in the Options screen. After loading the data, the Move and Find buttons are enabled: 

  
Figure 45 Main screen after loading data 

Any tags which have been applied to the loaded data are shown in the box to the right of the Tags 
label. The Move button displays the image with sequence number shown in the box to the right of it.  

Zoom 
Preset zoom factors of 100%, 150% and 200% can be applied via the Image->Zoom menu items. 
Holding the Shift key and pressing the Up key zooms the image by a small amount, and Shift-Down un-
zooms it. Clicking and dragging moves the displayed area through the zoomed image. The Zoom factor 
is reset to 100% when a folder is opened or re-opened. An alternative to zooming is to use the 
Windows native magnifier (zoom in via Window Key and the + symbol and out by Windows and ς 
symbol) or a magnifying glass program such as Virtual Magnifying Glass. 

https://sourceforge.net/projects/magnifier/
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Brightness & Contrast  
The brightness and contrast of displayed images can be displayed via the Image-> Contrast & 
Brightness menu item which displays the screen below. Both values are set to default values when a 
folder is opened or re-opened 

 
Figure 46 Brightness & Contrast Screen 

Show Detection(s)  
This menu option (with Ctrl-D as a keyboard shortcut) shows the content of all detections in the image 
as individual windows scaled to the aspect ratio of the detections as shown below: 

 
Figure 47 Detection Image example 

Detection windows can be resized by dragging corners or changing height. The magnification of 
detections facilitates correct identification of species. Clicking on the Similar Images button above the 
detection image loads the detection image into Google Image Search which shows results as below: 
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Figure 48 Google Image Search Results Using Detection Image 

If the detection image has adequate resolution, these results can indicate the name of the species 
present in the image. 

Find  Button  
The Find button ( ) shows the screen below: 

 
Figure 49 Find Image Screen 

Entering a string in the Search String box shows the first loaded file whose path contains the string 
(often the numeric part of the file name). Matches are also shown in the results combo box. These can 
be shown by selecting them in Results. 

Slideshow 
SlideShow->Info displays this section of the help file. Slideshow->Play displays all images starting from 
the first one at a time interval selected from the Slideshow->Interval menu item. The keyboard 
shortcut for this menu item is Ctrl-P. Other slideshow options are as shown below: 
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Clicking the Play menu item or Ctrl-P on the keyboard displays each item sequentially from the 
sequence number defined by Move Play Start To for a period defined by the Interval menu option, and 
the menu item name changes to Pause. The Stop menu item (with keyboard shortcut esc) is now 
enabled, and clicking it returns to caption entry mode. After clicking Stop, clicking Play resumes 
playback from the stopped sequence number. Clicking the menu item now named Pause (or clicking 
Ctrl-P again) stops slideshow playback. Clicking this (or Ctrl-P) resumes playback. The position at which 
playback is resumed is controlled by the Move Play Start To menu option, which is shown in the screen 
below: 

 
Figure 50 Move To screen 

The Step Forward and Step Back controls move to the next or previous item in the slideshow. The left 
and right arrow controls provide the same functionality is no caption or sub-caption text is present. 
The sequence number of an item is shown at the top left of the screen as shown below with sequence 
number 18: 

 
 
 
Copy To Folder (or Ctrl-K) allows copying of the current image (and optionally images ahead or behind 
the current image via the Images Ahead and Images Behind combo boxes) to a folder, the default 
value of which is My Pictures/Camera Trap Images via the screen below: 
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Figure 51 Copy to Folder screen 

A different folder can be selected via the Browse button. If an image file with the name shown above 
already exists in the folder, the saved file name has an integer appended to the file name before the 
file extension (eg IMG_0048(1).jpg).  

 
Start and End change the current item to the first or last loaded item. 
 
Interval sets the time period of the timer displaying image files via the screen below: 
 

 
Figure 52 Setting slideshow interval 

If the time period is shorter than the time taken to load the image (as may happen for large images, a 
short period, or a slow computer), the image is displayed on the next tick of the timer, so the actual 
period between displays will whichever integer multiple of selected period is greater than the time 
taken to load the image. The actual speed of the slideshow depends on the size of the images, the 
storage access speed and the speed of the computer being used. Using a 3.5 Ghz, 6-core computer 
with 2688x 1504 pixel images processing images on an external USB drive, a speed of 4 images/sec 
was obtained. 
 
If the Time Analysis screen is displayed, the selected image marker (a green dot) will move as the 
slideshow progresses. Clicking a different point on the displayed Count vs Time data will make the 
selected point the next one shown in the slideshow. 
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Metadata  
Metadata for the currently viewed file can be shown by clicking the Metadata top-level menu item. 
Metadata from the Windows filesystem is shown first, then image-specific metadata. There may be 
hundreds of fields present. ICC Profile entries for red, green and blue are not shown as they are very 
long. An example of camera trap image metadata is shown below 

 
Figure 53 Metadata (part) of camera trap image 

Errors  
Errors generated in the course of CamTrap Pro operation can be viewed by clicking the top-level Errors 
menu item as shown below: 

 
Figure 54 Errors from Current Instance 

The default option is to show only errors which have occurred during the current run, (Current 
Instance in the combo box to the right of the error display) but errors from all runs can also be 
displayed: 

 
Figure 55 Display of All Errors 
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Adding Tags Manually  
If single camera trap images are to be tagged, text may be typed in directly to the Tags Box (if Only Set 
Tags from Presets is not checked) and applied either by tapping the Enter key or by clicking the Apply 
button. If Only Set Tags from Presets is checked, the tag must be added to the Presets list. Tagged files 
have a yellow icon as shown below: 

 
Semicolons should not be used in tag names. Tag Information can be displayed in Windows Explorer 
using Details view: 

 
Figure 56 Windows Explorer details view showing tags 

Using Pre-set Values for Tags 
If users wish to select tag values from a list rather than typing them in, this can be achieved via the Tag 
button on the main screen or the Load->Tags menu option (Ctrl-T) which shows the screen below. The 
option to tag only the current image or all loaded images is then shown. If Presets Only on the 
Advanced tab of the Options screen is checked, tags can only be added via this screen. 

 
Figure 57 Preset Tag Screen When no Tags Loaded from Main screen 

As there are no pre-defined pre-set text options, only the Add and Close buttons are enabled, Clicking 
Add shows the screen below, which allows definition of one or more pre-set text strings to use as tags. 

 
Figure 58 Screen for Adding Preset Texts 

Multiple strings (the names of animal expected to appear) can be loaded from a text file in which each 
string is on a new line using the From File button or they can be pasted using one line per name. 
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Names may be animal common names (eg Magpie), 2-part names where one part describes the type 
of animal (eg Bird) or the full scientific name (eg Gymnorhina Tibicen). Category values used in JSON 
files can also be added via the From Categories button. After clicking Add and then Cancel, the text 
strings added appear in the main Presets screen as shown below: 

 
Figure 59 After Adding Pre-set Texts to single file from Main Screen  

The number of animals appearing in the image can be entered in the Count column if required and is 
appended to the tag name if it is greater than 1. The Tags column shows the cumulative number of 
files to which the tag has been added. It can be reset to zero on loading a folder. The display can be 
sorted in descending order by the number shown in the Tags column by selecting Tag Count from the 
Order By combo box as shown in the Multiple Files example. Checking Hide Unapplied hides all tags 
which have not been applied. Clicking the Example Images button performs a Google search with the 
default browser using the tag string appearing in the Tags box. If this is empty Google is opened but no 
search is run. Start Seq and End Seq show the range of seq numbers of files that the tag is added to. If 
Tag Multiple is clicked on the Count vs Time screen, End Seq will be greater than Start Seq if more than 
one point is shown. 
 
Clicking Apply adds the tag to the image.  

 
Figure 60 Windows File Explorer Detail view of files after applying tag 

Tags can be removed by clicking Clear and then Apply. If multiple tags are checked, they are separated 
by semicolons in the Tags box. 
 
One or more checked texts can be deleted via the Delete button (after confirmation) and if a single 
text is checked, its value can be edited via the Edit button. 
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Processing Multiple Image s 
Adding tags to a sequential group of images is performed via Tag Multiple button the Analysis-> Count 
vs Time screen which shows the Show Tags or Highlights screen. The Show Highlighted, Show Tagged 
by CamTrap Pro and Show Tag on Count vs Time options should be checked as shown below. 

 
Figure 61 Show Tags or Highlights 

With the options shown above, Count vs Time points will appear as shown below if no highlights have 
been generated via loading of the JSON file from machine learning analysis. 
 

 
Figure 62 Count vs Time screen with no highlights or tags created 

If highlights have been created for images, these are shown as below: 

 
Figure 63 Count vs Time showing Highlights on almost all files 

The sequence numbers of the first and last images displayed and the number of images with 
detections above and below the threshold value are shown below the chart.  
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Tag Multiple  
Clicking the Tag Multiple button on the Count vs Time screen shows the screen below, which extends 
the functionality of the screen shown in Figure 57. 

 
Figure 64 Tag Multiple screen 

Once the image has been inspected and the species present identified, one or more tags can be 
selected from this screen. The number of animals or birds present in the image can be entered in the 
Count column. Example images for different species expected to be present can be viewed via the 
Example Images button, which shows images from a Google search using the content of the tag box as 
a search phrase. If no text is present, the Google search screen appears. 
  
If Build Tag Summary after Application is checked, the Tag Summary is refreshed after tags have been 
applied. If Add to Existing Image Tags is checked, tags selected are added to those already existing. 
The Tag combo box All options applies tags to all files visible on the Count vs Time screen and is only 
shown if the Highlights Only filter is applied. Tag application may be slow if the same animal appears in 
a large number of images. The 1st in Det Event option only applies selected tags to the first image in a 
detection event, the duration of which is specified in Options. This option is useful if there are a large 
number of images of the same animal, for example, a carrion-eater attempting to eat a bait. If this 
option is used, the number of images in the tag summary will always be 1 for each detection event, 
and the duration will be zero 

View Image 
If a filter has been applied when loading files (for example to show only highlighted files), species 
recognition may be improved by viewing zoomed images, images rejected by the filter or images 
existing at a higher resolution in another folder using Windows Photo Viewer. This facility is accessed 
via the View Image button on the Time Analysis screen. Clicking it shows the screen below: 

 
Figure 65 View Image in Folder Screen 

The default is to search for the file in the loaded folder. If a copy of the loaded folder (perhaps 
containing images at higher resolution) is available, this can be selected via the Browse button. The 
default folder to search in can be restored via the Reset button. If the file exists in the selected folder, 
clicking OK shows JPEG images in Windows Photo Viewer as below: 
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Figure 66 Selected Image Viewed in Windows Photo Viewer 

The image displayed can be zoomed, or the displayed file can be moved backwards or forwards in the 

selected folder via the  or  button. Viewing other images than those highlighted may assist with 

species identification, as may using the zoom button  to show a zoom slider: 

 
Figure 67 Windows Photo Viewer Zoom Slider 

If an image is viewed in Windows Photo Viewer, closing it will also close the View Image in Folder 
screen shown in Figure 65. While the image is shown, the View Image in Folder screen is disabled and 
cannot be closed. If Show Containing Folder is checked, File Explorer is opened to show the folder 
containing the selected file. 
 
If the data consists of JPEG files extracted from video files, the parent video of the selected file is 
shown in the default video viewer. 

Adding Tags 
Selecting a tag copies it to the Tag text box. If more than one tag is selected, all selected tags are 
copied separated by a semicolon. The Clear button clears the tag box and unselects all preset values. 
Applying an empty string removes any existing tags if Add to Existing is not checked. If Add to Existing 
is checked, any existing tags will have the selected tag (or tags) appended to the tag string with each 
tag separated by a semicolon. If Build Tag Summary on Completion is checked, a Tag Summary will be 
generated which can be viewed via the Analysis->Summarise Tags menu item and clicking No at the 
prompt below: 

 
Figure 68 Screen to optionally rebuild tag occurrence and summary data 
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The start and end values are the sequence numbers of the first and last images displayed in the Count 
vs Time screen, which can be changed by zooming the display. By selecting a region of the Count vs 
Time display showing a sequence of images captured over a short time (as below), multiple images of 
the same animal can be tagged.  
 
If Build Tag Summary on Completion is checked, a tag summary is generated automatically on 
completion, and added tags can be displayed on the count vs time profile as below: 
 

 
Figure 69 After applying a tag to multiple images 

Tag text is added where the is a space of more than 5 pixels between tagged points. 
 
Clicking Analysis-> Summarise Tags prompts the use to choose between rebuilding the summary or 
displaying one already created. If the option to Rebuild Tag Summary on Completion has been 
selected on the Tag Multiple screen (shown in Figure 64), No should be selected. 
 

 
Figure 70 Tag Summary Screen 

The Tag Summary screen is discussed in more detail on page 76 
 

Editing Tags 
Existing tags are shown below the image on the main screen when the image is loaded. These can be 
edited and reapplied via the Apply button. If identification of individual animals is required tags can be 
changed to include a unique identifier. 

Deleting Tags 
Tags on individual images can be deleted using the Clear button at the lower right of the main 
CamTrap Pro screen. To remove tags from multiple images, any text should be deleted from the Tag 
box and the batch operation should be run using the batch button. To remove tags from all images, 
click the Tags button in the Clear box in the Pre/Post Processing screen.  
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Adding Detections Manually  
If machine vision does not detect animals of interest or is not available, manually defining the 
bounding box of the image containing the animal may be useful if the content of the bounding box is 
to be exported. A bounding box can be defined and labelled by shift-clicking and dragging in the main 
screen display to give the display as shown below: 

 
Figure 71 Manual addition of a detection 

The Label or Delete Detection screen allows the detection to be labelled and the detection details 
stored in the file name via the Apply button. The detection confidence is set to 1.0, and the first 
parameter in the detection metadata string (described in Highlights on page 32) is set to 1, indicating 
that the detection can be edited. The label may optionally be applied as a tag. The detection may be 
deleted via the Delete button. After application, the bounding box position and dimensions can be 
adjusted by dragging any of the sides or corners of the box. Clicking the small square in the centre of 
the box shows the Label or Delete Detection screen, which allows the label to be changed or the 
detection to be deleted. 

Adding Tags Automatically  
Tags can be generated automatically by loading a JSON file produced by AddaxAI, optionally refined. 
Detections of categories without the Use column checked in the Machine Learning Categories grid will 
be ignored. The default settings show Megadetector categories and only use Animal detections. If the 
Show All is selected, all detections within the specified range in a single image will be highlighted. Tags 
can be generated as well as highlights by checking the Name as Tag option for the category. Whenever 
detection confidence falls within the defined limits, a tag corresponding to the category name will be 
applied, and a red square will be shown on the count vs time profile if Show Tag on Count vs Time is 
checked when Count vs Time is loaded as shown in Figure 76. 
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Refining Auxiliary Program  Results 
 Auxiliary programs such as AddaxAI allow results to be refined to identify particular species as shown 
below where Megadetector is used : 

 
Figure 72 Automatically generated tags using refined Megadetector results 

When a refining classifier is used with AddaxAI, tƘŜ ŦƛƭŜ ΨƛƳŀƎŜψǊŜŎƻƎƴƛǘƛƻƴψŦƛƭŜΦƧǎƻƴΩ ǎƘƻǳƭŘ ōŜ 
selected. The classifications defined are listed in the Options screen, together with the number of 
ƛƳŀƎŜǎ ƛƴ ŜŀŎƘ ŎƭŀǎǎƛŦƛŎŀǘƛƻƴΦ ¢ƘŜ Ψ¦ƴƛŘŜƴǘƛŦƛŜŘ !ƴƛƳŀƭΩ ŎƭŀǎǎƛŦƛŎŀǘƛƻƴ ƛǎ ŀǇǇƭƛŜŘ ǿƘŜǊŜ aŜƎŀŘŜǘŜŎǘƻǊ 
makes an over-threshold detection but the refining classifier doŜǎ ƴƻǘΦ Ψ¦ƴƪƴƻǿƴ !ƴƛƳŀƭΩ ŎƭŀǎǎƛŦƛŎŀǘƛƻƴ 
appears where both classifiers make over-threshold detections but the refining classifier does not 
detect a match any of the defined species. The red squares indicate where the refined classification 
confidence exceeds the classification limit, dark blue triangles where an animal has been detected, but 
the refined classification does not exceed the classification limit, and light blue dots where no animal 
was detected with a confidence greater than the detection limit. Limits are defined in the Advanced 
screen of AddaxAI as described on page 96. 
 
As well as Megadetector-refining classifiers, AddaxAI offers the option of using SpeciesNet, which 
detects animals directly and is used in the Wildlife Insights facility. SpeciesNet offers different sets of 
classifications depending on the location selected. Categories may include family and order to which 
animal detections belong rather than species names, and refinement of these categories on the basis 
of local knowledge may be required, using the Map Highlights to Tags functionality. 
 
If individual images are shown by right-clicking on a red square or dark blue triangle, the bounding box 
of the detection will be shown, but the category name will only be shown if the classification lower 
limit has been exceeded. 
 
The Highlight->Copy to Folder option will copy highlighted files and tagged files to the selected 
destination.  

https://www.wildlifeinsights.org/
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Comments 
Text can be associated with an image via the Image->Comment menu option which shows the screen 
below: 

 
Figure 73 Comment Screen 

Comments may include more detail about animals visible (such as gender) or the level of certainty of 
identification. The form is not closed after application and the content will change if a different image 
is shown on the main screen. Comments can be viewed in the exported data. 

Previously Tagged Data  
Images with tags previously created by other means can be loaded and viewed in the same way as 
untagged data, and analysed in the same way as if the images have been tagged within CamTrap Pro 
However, no data on the minimum and maximum number of animals appearing in a tag occurrence 
will be available. 
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Checking Name as Tag will apply tags corresponding to category names as well as creating highlights 
giving results as shown below for a dataset collected from a road with significant vehicle traffic. 

 
Figure 74 Results of setting Name As Tag for 3 different categories of automatic classification 

Points shown in red are detections with the displayed category. From this data it can be seen that the 
increase in detections after 1/11/2011 is largely due to vehicles. 
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Analysis  

 
Figure 75 Analysis Options 

These options analyse the camera trap image collections. 

Count vs Time 
This option shows a cumulative count vs time profile of the images similar to those shown on pages 
16-17. An option to show generated highlights, tags created by the current instance of CamTrap Pro, 
tags retrieved from file metadata, or below-threshold detections is shown as below. Checking Show 
Tags from File Metadata option will slow display of the count vs time profile. 

 
Figure 76 Show Tags or Highlights Options 

Files with highlights created by machine learning are flagged in blue (by default) and tagged files in red 
(by default) if the corresponding boxes are checked. Tag names are added if Show Tag on Count vs 
Time is checked. Files with detections with confidence below the lower threshold are flagged in 
orange (by default). Default colours can be changed in the Options Advanced tab. The current file 
shown on the main screen is shown as a green circle. Note that, any changes to the tag will not appear 
until points are refreshed (via View-.Refresh Points on Count vs Time or Ctrl-E) or Count vs Time is 
reloaded. The Count vs Time chart can be zoomed by creating a shaded box by clicking and dragging 
with the shift key depressed. A box will still be drawn if the shift key is not down but the display will 
not be zoomed. 
 
For a multi-camera data set using Folder>Modified ordering, individual camera profiles are stacked 
and labelled as shown below. Note that the input data must be reloaded to manifest changes in 
ordering. If the number of files loaded exceeds 100,000 the screen may not resize to fill the window 
and may not be responsive to menu selections. Loading of data from JSON file may stop if the number 
of files loaded exceeds 60,000. In this case the application becomes unresponsive to menu selections 
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and can only be closed. If the number of file loaded exceeds 100,000 a message box appears requiring 
confirmation to continue and suggesting reduction of the number of files loaded. 

 
Figure 77 Count vs Time profile using Folder->Modified ordering 

Show Start shows the first file loaded. Time Grid Interval allows selection of the time interval between 
vertical lines on the profile. The function of the View Image button and that of Tag Multiple on page 
54. 

 
If Modified ordering is used, the individual camera profiles are summed as shown below: 

 
Labelling of data from individual cameras is not shown in this case. 
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If Show Tagged is checked, applied tags are shown as below in a colour specified in Options: 

 
Figure 78 Count vs Time with Tags Images shown 

If Show Highlighted is checked, highlighted images are shown as dots in a colour specified in Options: 

 
Figure 79 Count vs Time with Highlighted Images Shown 

Profiles can be displayed as either lines or points (coloured light blue) as specified with radio buttons 
at the bottom right. The arrow buttons to the right of the radio buttons move the selected point left 
or right along the sequence. 
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Figure 80 Count vs Time in Point mode 

If the profile contains a number of large sharp steps as shown in Figure 62, this indicates that animals 
are moving in the viewed scene for some time and that tags need to be applied in bulk. This can be 
done manually in CamTrap Pro, or using the Exif Pro application, which allows application and removal 
of tags to a subset of loaded images. Megadetector uses machine learning to automatically detect 
animals in images and can be accessed from CamTrap Pro and applications such as AddaxAI. Output 
from this process can be loaded into CamTrap Pro. 
 
The appearance of large step in the Count vs Time profile (as shown in Figure 62) indicates that an 
animal moving in front of the camera is triggering it more often than the more random false 
triggerings from moving shadows or vegetation. The profile can be zoomed by clicking and dragging to 
create a box around the area of interest (near the origin) as shown below left. The zoomed display is 
shown below right. 

  
Figure 81 Zoom box defined on Count vs Time profile (left) and zoomed display (right) 

The sequence number of the image corresponding the cursor x location is shown in the lower left-
hand corner when the cursor is within the profile area. 
 
The Show Start button shows the first image after the start of the displayed region, and right-clicking 
on the display near a time-count point shows the image. If only a single time/count point is within 5 
pixels of the cursor, the cursor changes to a + and right-clicking shows the image. If more than one 

https://download.cnet.com/ExifPro/3000-12511_4-10436338.html
https://github.com/microsoft/CameraTraps/blob/main/megadetector.md
https://github.com/PetervanLunteren/EcoAssist























































































